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 AB210-4 Are you ready to take the next step and use building information modeling to share data 
across the entire design team? As more people adopt BIM, the need for sharing data and 
information across disciplines has become increasingly critical. In this class, we will look at 
how the Revit platform facilitates collaboration and coordination among architects and 
engineers. We’ll examine how to link project files between Revit Architecture, Revit 
Structure, and Revit MEP, coordinate work between disciplines, identify and correct 
interferences, and use Revit’s revision tracking to keep track of changes. 
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Introduction 
As more people adopt Building Information Modeling (BIM), the need for sharing data and 
information among disciplines has become increasingly critical. The Revit platform facilitates 
collaboration and coordination among members of an extended design team by providing tools 
enabling better understanding of designs and methods to enhance communication between 
design team members. Through the use of these tools, architects and engineers using Revit 
Architecture, Revit Structure, and Revit MEP can coordinate work between disciplines, identify 
and correct interferences, and use Revit’s revision tracking to keep track of changes. 

In most building projects, a team of architects, engineers, and others collaborate on the overall 
building design. For example, a mechanical engineer uses an architect’s building model as the 
starting point in the design of the HVAC system. Proper coordination and monitoring helps 
ensure that the mechanical model is synchronized with the changes that the architect makes to 
the building model. Effective change monitoring can reduce errors and expensive rework during 
construction. 

This class will look at the tools in all three versions of Revit that enable architects, engineers, 
and other team members to collaborate together. Key to making this work are Revit’s file linking 
tools. While file linking can be used to link a number of different types of files into a Revit 
project—for example, you can link details created using AutoCAD into a Revit project so that 
they can be tracked and managed as part of a complete set of construction documents—this 
class focuses on linking various Revit files. 

An important aspect to consider when linking those files is how they relate to each other within 
three-dimensional space. One way to ensure that the architect’s model and the structural 
engineer’s model actually fit together is to share the same coordinate system. Although we can 
also share this information between Revit and AutoCAD, this class will focus just on sharing 
positions between Revit project files. 

Once we have linked project files together, we need to be able to manage those links. For 
example, if the architect’s model changes, the structural engineer needs to be able to reload the 
architect’s model so that he can see those changes. 

The engineer also needs to be able to understand how he can change the appearance of the 
architect’s model within the context of his structural model, and vice versa. So we will look at 
how you can control the visibility of objects within linked files separately from those in the Revit 
project that is hosting those links. 

A key aspect of collaborating within Revit is the ability to monitor changes that occur within 
these linked files. So we will look at how this monitoring function actually works. 

When changes do occur—for example, if the structural engineer changes the size of columns 
and beams—the architect needs not only to be alerted to those changes, but also to be able to 
appropriately respond to those changes. So we will look at Revit’s project coordination tools 
designed specifically for this purpose. 

We will also look at tools built into Revit that enable us to see if there are any conflicts between 
components. For example, is there really enough room to run the HVAC system within the 
space between the architect’s ceiling and the structural engineer’s beams. 

And finally, when changes need to be made within the drawings, how can we track those 
revisions? 
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File Linking 
The first step in sharing information and collaborating between disciplines is to link the Revit 
files together. For example, a structural engineer can link in an architectural model and use it as 
a base for creating and analyzing a structural model. The structural engineer can share his 
model with the MEP engineer, so that the engineer can create an MEP model on the same 
design. The architect can then link both the structural and MEP model back into the original 
architectural model. 

You link Revit project files using the File Linking tool. This is similar to creating an external 
reference in AutoCAD. When linking, select Auto – By Shared Coordinates to specify the 
positioning of the linked model in the host project. 

 
When you link one Revit project file into another, its path is saved in the host Revit project file. 
After linking, if the linked project file changes, you can reload it in the host project file to view the 
updated linked project file. If the path of the linked project file changes, you can update its path 
in the host project file using the Manage Links dialog. 

Note: You can select a linked project file and bind it into the host. Binding converts the linked 
file to a group within the host file. You can then edit the group or ungroup objects. You can also 
convert a model group into a link, which saves the group as an external file. To bind a linked 
project, select the link and then click the Bind button on the Options bar. 

You can also insert 2D elements or drafting views created in one Revit project into another 
project using the Insert from File command on the File menu. You can also insert schedules 
created in one Revit project into another. The inserted schedule retains the formatting of the 
original Revit project. 

Dealing with Positioning Issues 
In some situations, you may have to deal with discrepancies in the positioning of the geometry 
in the linked project relative to the host project. For example, if the architect has begun her 
design of the project using Revit Architecture and the structural engineer has also begun his 
design using Revit Structure, when the structural engineer links in the Revit Architecture model, 
it may not share the same coordinate system as his model. In that case, Revit will display an 
alert informing you that the current project and the imported instance do not share the same 
coordinate system and that Revit will default to center-to-center positioning. 

 
Revit may also display an alert letting you know that Revit is unable to get the center of the 
imported geometry in the current view to place the import. As a result, the imported file will not 
be centered on the current view. If you see either or both of these alert dialogs, simply click OK 
to clear them and continue. You will need to deal with these positioning issues once the linked 
file has been imported into the host. 
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Each Revit project has an internal coordinate system for all of the elements that comprise the 
model. Those coordinates are known only to that project. This is acceptable if you are working 
on a standalone model whose position is not relevant to any other model or to a site. However, 
if you want the position of the model to be known to other linked models, you need to share the 
coordinates. 

Shared coordinates are used for remembering the mutual positions of multiple interlinked files. 
Those interlinked files can all be Revit RVT files, or a combination of RVT, DWG, and DXF files. 

Although the default Revit template places the first level at an elevation of 0’-0”, some designers 
like to begin modeling their buildings with the first level placed at an elevation of 100’-0”, or they 
may have moved the levels to their actual elevation above sea level. The alert dialog described 
above will display any time the levels in the project being linked in do not match those of the 
project it is being linked into. If you see this message, it simply means that after linking you will 
need to adjust the levels of one project file to match those of the other. 

For example, the linked model may be positioned at a different elevation (and perhaps in a 
different location) relative to the current project. 

 
In that case, after linking the files, you can switch to an elevation view, zoom so that you can 
see the entire model, and then simply move the two models into the proper alignment. It really 
doesn’t matter which model geometry you move, although generally it is easier to move the 
linked geometry so that it matches the host model. After correcting the discrepancy in elevation, 
you may also need to move the linked file in a plan view as well. 

Shared Positioning 
Although in our example, we’ve moved the architect’s model so that it is in the proper position in 
relation to the structural model, if we were to stop here, the architect would end up having to do 
the same thing when she subsequently links the structural model into her architectural model. 
And that’s fine. But Revit’s shared positioning tools can eliminate the need to do this. 

It doesn’t matter whether you acquire the shared coordinates from the linked file or publish them 
from the host file. But you should derive shared coordinates from only one file. That one file 
defines the coordinates for all other files that compose the project. Acquire coordinates from one 
file and then publish those coordinates to the other files. 

To acquire or publish coordinates through linked instance properties, select the linked model in 
the host project and then click Properties. In the Element Properties dialog, notice the button in 
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the value box next to the Shared Location parameter. It says Not Shared, which indicates that 
there is no coordinate sharing between the linked instance and the host model. 

Click the Not Shared button. Revit displays the Share Coordinates dialog. Because this is the 
first time that you are setting up shared coordinates between the host and the linked model, you 
need to reconcile the coordinates in favor of either the host or the linked model. You need to 
reconcile the coordinates only once. 

 
Select either Publish or Acquire. If you select Publish, you publish the coordinates of the host 
model to the linked model. The linked model coordinates change to those of the host model. If 
you select Acquire, you acquire the coordinates from the linked model to the host model. 

Since the method you choose can affect other team members, you should all agree which 
coordinate system will be used. For example, in a situation where you will be dealing with 
models created in Revit Architecture, Revit Structure, and Revit MEP, you might agree to use 
the coordinate system established by the architect. In that case, the structural engineer will 
select Acquire to match the coordinate system in his Revit Structure model to the coordinate 
system in the architect’s Revit Architecture model. The MEP engineer would also acquire the 
coordinate system from the Revit Architecture model when he links that model into his Revit 
MEP project. 

Regardless of the method you choose, the linked model’s position in the host model is saved to 
a location named in the linked model file. If desired, you can change the name of the location by 
clicking Change and selecting a name from the Select Location dialog. 

Click Reconcile to confirm the changes, and then click OK to close the linked model properties. 

Note that you cannot acquire coordinates or publish coordinates from a project that has multiple 
locations using the Acquire Coordinates or Publish Coordinates commands. You can do this, 
however, through the properties of the linked model. Also note that you don’t have to use 
shared coordinates when collaborating using linked files. Doing so simply eliminates the need 
for each of the other disciplines to move the linked file into the proper position. 

Managing Links 
In addition to the proper position of the linked project, the team members should also be aware 
of how Revit deals with any project files that were themselves linked to the project files that they 
link to their models. 
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Revit deals with linked files similar to the way AutoCAD deals with external references. There 
are two different ways in which one file can be linked to another: Overlay and Attachment. You 
can control the method used to link files from within the Manage Links dialog. To display this 
dialog box, from the File menu, choose Manage Links. 

The Manage Links dialog lets you control any files linked to the current Revit project. Notice that 
the dialog box has three tabs: CAD Formats, Revit, and DWF Markups. Linked Revit files 
appear on the Revit tab. 

Revit files can be linked using either 
the Overlay or Attachment method. 
Overlay is the default method. When a 
file is linked using the Overlay method, 
the linked file appears in the file it is 
linked into, but the link will not follow 
the host if the host becomes linked into 
another file. Using this method, if the 
architect subsequently links the 
structural model into her architectural 
project file, she will not create a 
circular reference back to her 
architectural file that had already been 
linked into the structural file. When a 
file is linked using the Attachment 
method, if the host file is subsequently 
linked into another file, all attached 
links are also included. 

If the architectural model had been linked to the structural model using the Attachment method, 
and then the architect subsequently linked the structural model into her architectural model, 
Revit would display an alert telling her that the file being linked contains a linked file that has the 
same name as the host model. In that case, Revit automatically unloads the attached link to 
avoid creating a circular reference. 

If the model being linked has other files linked to it using the Overlay method, Revit may display 
an alert telling you that those linked files will not be visible in the current project. 

 

Visibility Control 
Another issue that you may need to deal with involves controlling the visibility of objects in your 
model. When you have one or more models linked into a project, visibility control becomes a bit 
more complicated. You can’t simply go to the Visibility/Graphics dialog and turn off a category. 
Doing so would turn off all of the objects in that category within all of the linked models as well 
as within your current model. 

Instead, Revit provides a way to control the visibility of objects within each linked Revit model 
separate from those of the current host project. To do so, you must first change the control on 
the Revit Links tab of the Visibility/Graphics dialog by clicking the By Host View button. This 
displays a RVT Link Display Settings dialog. It is in this dialog that you will be able to control the 
display of objects in the linked file separate from those in the host project file. 
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When you have linked one or more Revit project files into the current project, the 
Visibility/Graphics dialog contains an additional tab labeled Revit Links. When you select this 
tab, you see each RVT file linked to the current project. The Display Settings for each is initially 
set to By Host View, which means that the changes you make to the display of objects in the 
current project also affect those of the linked project. 

 
If you click the By Host View button, however, Revit displays the RVT Link Display Settings 
dialog. This lets you control the visibility graphics for the linked file. To control its settings 
separately from the current project file, you need to make two changes. First, on the Basics tab, 
change the setting from By Host View to Custom. 

Then, select the Model Categories tab and from the Model Categories drop-down, select 
<Custom>. Now any changes you make within this dialog box will only affect the linked file. 
Notice that you can control this setting separately for the Model Categories, Annotation 
Categories, and any categories imported into the linked file. 

The following describes the settings available on the Basics tab: 

• By Host View. When you select this option, you cannot override any visibility settings for 
the linked model, because the host view governs its appearance. When the primary 
linked model is set to By Host View, each copy or instance of the linked model can still 
be overridden on an individual basis by checking the box for Override display settings for 
this instance. This option appears on the Basics tab when a copy or instance of a 
primary linked model is selected in the Visibility/Graphics dialog. 

• By Linked View. When you select this option, you can choose which project view 
should display for the linked model by choosing from a drop-down list. The views in the 
list depend on the view for which you are currently applying visibility and graphics 
settings. 

• Custom. When you select this option, you can select override settings on all available 
tabs. 

Note that filters do not apply to elements that are part of linked models. 

Monitoring Changes 
After linking Revit projects, you need to set up the collaboration mechanism. For example, the 
structural engineer needs to know any time the architect makes changes to her model that may 
affect his structural model, and vice versa. 

 
The tool in Revit used to set up this collaboration is called Copy/Monitor. To copy 
and monitor objects contained in a linked file, you activate the tool by choosing 
Copy/Monitor>Select Link from the Tools menu (or click the Copy/Monitor tool on 
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the Tools toolbar and then choose Select Link) and then click on the linked file. Revit 
immediately goes into Copy/Monitor mode. The Design bar changes to display the Copy/Monitor 
tools. You can then use those tools to select the objects you want to monitor. 

The first thing you may want to do is to click the Options tool. 
This opens the Copy/Monitor Options dialog. Elements 
available for monitoring are separated into five categories: 
Levels, Grids, Columns, Walls, and Floors. On each tab, the 
Original Type column identifies the type for the Revit 
Architecture file and the New Type for the corresponding 
element available in the template selected. Each tab provides 
various parameters that can be set for that specific element. 
You can also exclude element types that you do not want to 
copy. 

For example, if the levels already exist within the host model, 
you won’t need to copy them from the linked model. You would 
only need to monitor them. But if the levels don’t yet exist, then 
you would want to copy them into the host model and then 
also monitor the levels in the linked file so that if the architect 
changes the levels, the structural engineer will know about 
those changes. 

You can also add a suffix or prefix to level names and grid names so that if you do copy them 
you can more easily determine which ones are in the host model and which are coming from the 
linked model. 

The structural engineer also has the option of splitting columns by levels. Architectural columns 
typically extend through multiple levels of a model. For example, the architectural columns may 
span from Level 1 to Level 10. But this may present a problem when the structural analytical 
model is generated. Therefore, the structural engineer will want to split the columns at each 
level. 

After setting the Copy/Monitor options, you’re ready to select the objects you 
want to copy. As you select the objects you want to copy and monitor, Revit 
displays an eyeball icon adjacent to those objects, so that you can see which 
objects are being monitored. 

When you select objects to copy and monitor, you can select the 
Multiple check box on the Options bar so that you can select multiple 
objects at one time. Then click on each object you want to copy. To select multiple objects, hold 
down the Ctrl key while making selections. You can use the Filter tool to de-select anything that 
you don’t want to monitor. When you are finished making selections, click the Finish button on 
the Options bar. 

You may need to repeat this process in multiple views. For example, you will probably need to 
repeat these steps for each level in the project to copy any structural walls and columns on that 
level, and also display a building elevation view to copy the levels and floors. You can continue 
to add objects that you wish to monitor by using the tools on the Copy/Monitor panel in the 
Design bar. When you have finished selecting the objects you want to copy and monitor, you 
must exit the Copy/Monitor mode by clicking the Finish button on the Design bar. If you click 
Quit Mode, the objects you selected will not be monitored. 
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The Copy/Monitor tool can only be used on those categories that would actually impact the work 
of the other design team members. Specifically, Copy/Monitor only works with grids, levels, 
columns, walls, floors, and openings, and in the case of Revit MEP, rooms. 

Note that the more objects you monitor, the slower the performance may become and the more 
complicated it can be to track changes. You should only monitor key objects. 

Structural Usage 
Walls created in Revit Architecture present a bit of a special case. By default, most walls 
defined in Revit Architecture are not structural walls and therefore cannot be copied and 
monitored when linked into a host file. Only structural walls can be copied and monitored in 
Revit Structure. 

In order for walls to be copied and monitored in Revit Structure, they must first be defined in 
Revit Architecture as structural walls: either Bearing, Shear, or Structural Combined. 

 
Floors can be copied from Revit Architecture to Revit Structure, but may need to be changed to 
structural floors. To do this, select the floor in Revit Structure, display its element properties, and 
select the Structural check box. 

Project Coordination 
With the project linked and monitored, you can continue to work as usual. If you receive an 
updated file from you project team members, Revit will automatically update links to that file the 
next time you load the host project. If you receive the updated file while you’re working within 
the host file, you can reload the link by using the Manage Links tool (or by right-clicking on the 
linked file under Revit Links in the Project Browser). 

 
If a monitored object has been changed and 
requires attention, Revit displays a dialog box 
informing you that an instance of a linked RVT 
file needs Coordination Review. This lets you 
know that you will need to perform a 
coordination review to address the changes. 
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To perform a Coordination Review, from the Tools menu, choose Coordination Review>Select 
Link, and then click on the linked model. As soon as you select the link, Revit displays the 
Coordination Review dialog. This dialog box displays a list of all of the changes that require 
some type of action. The messages in this dialog box identify elements that were deleted, 
moved, or changed in some way in the linked file. In this case, the structural engineer should 
address each message individually and take some form of action to resolve the conflict. 
Whatever action you take changes the element in the current project, not in the linked project. 
Actions include: 

• Postpone/Do Nothing: Take no action on the element. This changes the message 
status so that it can be filtered out or considered later. 

• Reject: Makes no change in the host file. The change made in the linked file appearing 
in the host file is incorrect and a change must be made to the associated monitored 
element. You will need to communicate this information back to the other project team 
member to resolve the problem. 

• Accept Difference: Accepts the change made to the element and updates the 
relationship. For example, if a pair of grids were 25’-0” apart and one was moved to 
30’-0”, accepting the difference would change the relationship to 30’-0”. 

• Modify/Rename/Move: The name of this command changes based on the action 
required. If the name of the monitored element has changed, the command reads 
Rename and choosing this option renames the element. If a column or level is moved, 
the command reads Move and choosing this option moves the element to match the 
change made in the linked file. If a grid is changed or moved, the command reads 
Modify and choosing this option modifies the grid. This is the option you will choose if 
you agree to the change in the linked file. 

For each change, you can decide if you accept or reject the change. Or, if you don’t want to deal 
with the change until later, you can choose to Postpone any action. 

If you aren’t sure what or where the changed objects are, you can click the Show button to have 
Revit switch to a view in which you can see the object so you can properly identify the change 
that has been made. 
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You should work your way through the list, selecting the appropriate command next to each 
warning. If desired, you can click Add Comment to enter comments on your action. Enter 
comments into the Edit Comments window and then click OK. In this way, you can 
communicate the reasons for your decisions to other team members. 

Once you have dealt with all of the items in the Coordination Review dialog, the list should be 
clear and your project is coordinated. 

Of course, as your project proceeds, you will probably receive further updates from the other 
members of your design team. When you update the links, Revit may warn you again that 
coordination review is required. So you may need to repeat this process a number of times as 
the project is developed. 

If you select postpone or reject, you can always return to the Coordination Review to re-
evaluate those issues. 

Note that Revit will only alert you to changes made to elements that you are already monitoring. 
If new elements that need to be monitored have been added to a linked file, those elements will 
not be monitored unless you use the Copy/Monitor tool to add them. So it is important that team 
members continue to communicate with each other throughout the course of the project. 

Interference Check 
In addition to the coordination tools, Revit also includes tools to help you identify and correct 
interference conditions, such as when a structural beam interferes with an HVAC duct. 

You can run an interference check at any time. To do so, from the Tools menu, choose 
Interference Check>Run Check. Revit displays the Interference Check dialog. You can check 
for interference conditions between objects within the current project and between objects in a 
linked project. You cannot run a check between two different linked files, however. 

The Interference Check dialog has two columns. Initially, both of these columns list objects in 
the current project. To compare one or more types of objects in the current project to another 
set of objects in a linked project (such as checking to see if any beams interfere with ductwork in 
a linked MEP model), select Current Project in one column and the linked project in the other. 
Then select the objects in the current project (such as the structural framing) and the object in 
the linked project (such as the ducts, duct fittings, and mechanical equipment) and then click 
OK. 
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Revit immediately runs the interference check and then displays a report showing all instances 
of interferences between the selected objects. You can expand each instance to see the report 
in more detail. As was true for the coordination report, if you aren’t sure what or where the 
interfering objects are, you can click the Show button to have Revit switch to a view in which 
you can see the objects. You can also export the interference report to an HTML file. 

 
Once you have identified an interference condition, it is up to you to use the various tools in 
Revit to correct the problem and resolve the interference. Once you have made the necessary 
corrections, click the Refresh button to update the report. When the interference has been 
resolved, it is removed from the report. When the list is empty, all of the interference conditions 
have been resolved. That is, there are no longer any interferences between the set of 
component types that were compared. You may still need to run other interference checks 
between other categories of objects to make sure no other collisions exist. 

Revit will not automatically solve interference conditions, but the interference check tool goes a 
long way toward helping find and deal with interference conditions during the design of the 
building. Used efficiently, there is no longer any reason to remain unaware of conflicts until 
during construction, when solving them is likely to result in a costly change order. 

Revision Tracking 
All three flavors of Revit also provide tools that enable you to track revisions you make to your 
project. You can create a sequence of revisions and you can draw revision clouds around 
elements in your project that have changed. You can use revision tags to notate the revision 
clouds, and then display the revisions in schedules that appear in the title block of each project 
sheet. 

The first step in using revision tracking is to set up the revision table. Revit provides tools for 
this. From the Settings menu, choose Revisions. Then, in the Revisions dialog, select the 
method you want to use to track revisions. 

If you select By Project, all revisions are numbered according to the sequence of revisions in the 
Revisions dialog. If you select By Sheet, revision clouds are numbered relative to the sequence 
of other clouds on a given sheet. 

Within this dialog, you also specify the release date of the revision and provide a description as 
well as control other aspects of each revision. In general, revision descriptions should be 
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comprehensive, yet as concise as possible. Be sure to leave the Issued check box cleared at 
this time. When Issued is selected, the revision is locked and issued to the field. 

 
Next, you need to indicate the changes within the drawings that are part of the revision. You do 
this using the Revision Cloud tool. This tool is located on the Drafting tab of the Design bar. 
Generally, you will add revision clouds while working in a sheet view, but you should add the 
revision to the specific view within that sheet, so you will need to select the view and activate it 
by right-clicking on the view and choosing Activate View. 

Then, select the Revision Cloud tool and start 
adding cloud segments, working your way around 
the area of the drawing that needs to be revised, in 
a clockwise direction (so that the cloud bulges 
outward). Continue adding segments until the cloud 
surrounds the area that you changed. Then, on the 
Design bar, click Finish Sketch. 

Remember that the appearance of the revision cloud is controlled using the Visibility/Graphics 
settings, just like any other object in Revit. 

To add additional revision clouds that relate to the same revision, simply draw another revision 
cloud. To add a revision cloud that identifies a different revision, you must first add the new 
revision to the Revisions dialog. To do this, open the Revisions dialog again, click the New 
button to add a new row to the revision table, and then specify the pertinent information for the 
new revision. 
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Note that when you add your next revision cloud, it will automatically be assigned to the new 
revision you added. But you can change this by selecting the revision cloud and opening its 
Element Properties dialog. You can then select the revision number from the drop-down under 
the Identity Data. 

When you’re ready to tag the revision cloud, in the Drafting tab of the Design bar, choose 
Tag>Tag by Category, and then simply click to select the revision cloud. Revit automatically 
tags the cloud using the revision number assigned to it. If you change the revision number 
assigned to the revision cloud (by changing the revision cloud’s element properties), the number 
in the tag automatically updates. 

Remember that the numbering method used is based on the selection you made (by sheet or by 
project) when you first set up the revision table. 

You can continue to modify a revision until you release that revision. Once the revision has 
been released, you can no longer make any modifications to that revision. You cannot add 
revision clouds to the revision, you cannot edit the sketch of the revision cloud, and you cannot 
use the Element Properties dialog to change a revision cloud if its revision has already been 
issued. 

 
As you add revisions to the Revisions dialog, Revit automatically adds them to the revision 
schedule that appears in the title block of each project sheet. 

Conclusion 
Revit provides all the tools you need to collaborate across disciplines, linking data created by 
architects, engineers, and other consultants. Revit by itself won’t prevent conflicts from 
occurring, but it helps facilitate improved communication between project team members. You 
can use the tools in Revit to ensure that your designs are accurate, coordinated and complete. 
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